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1 About this document

1.1 Other Applicable Documents

The information for the AG4 Safety Laser Scanner is covered within multiple documents. The documents and software for configuring the AG4 are
contained on the CD that comes with the product.

Document Title Document Content Source

AG4 SERIES SAFETY LASER

GENERAL PRODUCT INFORMATION AND P/N 145034, INCLUDED WITH THE PRODUCT IN PRINT AND
SCANNER QUICK-REFERENCE

DIAGNOSTIC REFERENCE oN CD-ROM
UsEeR GUIDE
AG4s0FT PROGRAM CONFIGURATION AND DIAGNOSTIC SOFTWARE [AG4SOFT, INCLUDED WITH THE PRODUCT ON CD-ROM

AG4 SERIES SAFETY LASER  |AG4 OPERATION CAPABILITIES, FUNCTIONS,
SCANNER USER MANUAL AND APPLICATIONS, FOR THE MACHINE P/N 144924, INCLUDED WITH THE PRODUCT ON CD-ROM
(THIS DOCUMENT) DESIGNER, INSTALLER AND END USER

How To: CONFIGURE OPERATIONAL

AG4 SOFTWARE MANUAL SETTINGS, ACCESS DIAGNOSTIC
INFORMATION, AND MANAGE CONFIGURATION
FILES

P/N 144923, INCLUDED WITH THE PRODUCT ON CD-ROM

AG4 SERIES SAFETY LASER  |Application examples intended to give

PIN 147 INCLUDED WITH THE PRODUCT ON CD-ROM
SCANNER APPLICATIONS GUIDE |additional guidance in applying the Scanner / 900, e opucT oN €D-RO

. Instructions for daily and semi-annual P/N 147899, INCLUDED WITH THE PRODUCT ON
AG4 Series Safety Laser , . .
checkouts of Scanner installation CD-ROM, to print as needed and post near the guarded
Scanner Checkout Cards equipment

The current software version and all PDF documents can be downloaded from the Banner website http://www.bannerengineering.com.
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2 System requirements

2.1 Computer

A PC with the following specifications is required to use the software:

Processor type

Intel® Pentium or comparable, e.g. AMD® or Cyrix®

Operating system

Microsoft® Windows 95/98/NT®/2000/XP®

RAM

At least 64 MB

Hard disk memory

At least 50 MB free memory
You require more memory space if you want to save protective field
or configuration values.

Screen display

Color

External drive

CD drive

Input device

Keyboard and mouse or touchpad

Output device

Printer (black and white or color)

Serial interface

RS232 or RS422
Use an appropriate adapter if the PC has a USB interface instead of
a serial interface.

144923 rev. A 02/2010
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3 AG4soft Overview

The AG4soft program is used to both establish operational settings for the Scanner and to display measurement and system information produced by the
scanner. Communication between the PC and the AG4 is via an RS232 interface, either RS232-t0-RS232 or USB-to-RS232.

Use this software only for Banner AG4 Series Safety Laser Scanner.

3.1 Configuration

The AG4 Scanner is preprogrammed at the factory with a default configuration but must be reconfigured for each application. The factory default
configuration is stored as a file (standard.rs) in the AG4soft program directory during the software installation on the PC:

C:\Program Files\Banner Engineering\Banner AG\AG4soft\examples

3141 Configuring the AG4

The configuration settings are created by a trained and Qualified Person who understands the AG4 instruction materials. These settings are saved in a
configuration file which has the *.rs file format and includes all the information that the AG4 requires for its intended operation. An AG4's configuration file
includes the following data:

= Administrative data, e.g. file name, application description

=  Safety-relevant data, e.g. startup process

=  Protective Field or warning field configuration data, e.g. contours and limits

A wizard in the program assists users with the AG4 configuration process.

31.2 Protective and Warning Fields

The software makes it easy to establish protective and warning fields. The protective field and the warning field are user defined areas that the Scanner
monitors. An intrusion into the protective field (e.g. a person walking into a monitored work cell) will cause the Scanner to turn its safety outputs off. An
intrusion into the warning field will cause the Scanner to create a warning signal.

Protective field and warning field settings are created and saved as field pairs. Up to 8 configurable field pairs are available for the AG4. A field
configuration file has the *.sf file format and includes data on the size of each protective and warning field. Field pairs can be enabled or disabled, one
field pair at a time, while the Scanner is operational and actively monitoring a work area. This function is useful when changing machine guarding
requirements create the need for changes in protective and warning field dimensions.

Banner AG4 Software Manual 144923 rev. A 02/2010 7
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3.2 The Monitored Space Display

When a Scanner is actively monitoring an area, it measures the distance to, and the angular position of, objects in the area. These measurement data are
transferred via the RS232 connection from the AG4 to the PC. The AG4soft program uses this data to constantly update the display to show the protective
and warning fields along with the measured surfaces of the monitored area (see Figure 1 below).

b AG4s0ft

File View Settings Configuration Protectivefwarning fields  System data  Security  Help

Measured contour display

QR 2id

H+h

-0.791 m 1.720m 55.20 ° 1.893 m

1116 m 1.754 m 57.55 * 2079 m |—F|—
_ Fie | hd

/G4 Connection | AG4 Measurement mo)[PC > Measwed vaue display [ [Authorieed Customer [BC] (1

Figure 1 Display of monitored area along with the rectangular protective (red) and warning (green) fields
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4 AG4soft Interface

4.1  Interface Layout

In addition to displaying a graphic rendering of the monitored area, the software provides configuration and file management tools, including file title
header, drop-down menu bar, and function-specific worksheets which contains buttons relevant to the specific function. The menu bar and worksheets are
used to create or edit the AG4's operational and application settings (see interface and function key below).

File Name Header £ gﬂfm! Drop Down
File View Settings Configuration —Protective/warning fields System data  Security Help Menus
Worksheet Tabs ——> Mescdomoudssy [0 Coguton | Potsiesnnigles e | Suendsa |
Qe @lE = Worksheet Tool Bar
2.372-
2200~
2.000-
1.800-
1.600-
1.400-
Monitored Area 12001
(workspace) 1.000-
0:800- -

0600~
0.400-
0,200~
0.000-
0200
-0.300-,

1 1 ! | ! I ! | 1 1 1 I I ! I ' I ' ' '
-2736 2500 -2250 -2000 -1.750 -1500 -1.250 -1.000 -0750 0500 -0250 0000 0250 0500 0750 1000 1250 1500 1750 2062
Units in meters

Navigation Area

i X Field pairs active in the scanner: 1 Cursor position in relation to the laser scanner center point / Al
Field Information ————=>1 selsctedfield pais: i | Posiion ®05%m|  Y1007m | Ange53.40° | Radus1.170m || @
Data source [[Seafer| Fie | Endposiion X0E0Im| Y 100im | Ange 5303 | Radus1157m || W)
Status ————>>{js64 Cannecion | BG4 Measurement mor T Measured value disglay I | Euthorized Customer [AC] |
Information
Position |Name Description
1 File name header Identifies the configuration file that is being used
Includes functions for; software display & communication settings, AG4 configuration settings, file management
2 Drop-down menu bar . ) .
operations, system data access and fault diagnostics.
3 Function-specific These worksheet tabs provide access to the tool set and display that is appropriate for the specific configuration
Worksheets function or file operation being performed..
4 Monitored Area Display  |Graphically displays the monitored area and protective/warning field boundaries (contours).
L Displays both XY & Polar coordinates of the cursor position and contains an 5 button interface for changing the view
5 Navigation area .
of the monitored area.
6 Field Information area Identifies the number of active field pairs and the source of the configuration data
7 Status Information area  |Displays: AG4 - PC connection, data exchange, current active worksheet, field status and login authority information

Figure 2 AG4soft Interface
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4.2 File Name Header

The file name header (refer to Figure 2) identifies which configuration file is active in the AG4soft program. This file can be retrieved from the AG4soft
system folder or can be pulled in from an AG4 scanner.

4.3  Drop-Down Menu Bar
The Drop-Down Menu Bar provides access to the following functional areas:
=  File - load and save both configuration and protective/warning field files
= View -- change the field of view or save a copy of the monitored area being displayed
= Settings -- access worksheet functions or change PC and worksheet display settings
= Configuration -- configuration file edit and transfer operations
=  Protective/warning Field -- field parameter file edit and transfer operations
=  System data -- data used for fault diagnostics and maintenance purpose
= Security - password change options

= Help - instruction manual and reference material access

4.4  Function- Specific Worksheets
Each worksheet has a specific set of tools and a monitored area or worksheet display that is helpful when using the tools. The worksheets provide access
to the following functions:
= Measured contour display -- a “real time” display of the surfaces and protective/warning fields in the monitored area.
=  Configuration -- configuration file edit and transfer operations
=  Protective/warning fields definition -- field parameter file edit and transfer operations
= System data -- data used for fault diagnostics and maintenance purpose
Each worksheet includes a set of functions that are enabled according to the user authorization level.

Each Function-specific worksheet corresponds to a specific set of functions needed to create or
- edit AG4 configurations.
LL NOTE: The selected authorization level determines which worksheet functions are available.

4.5  Measured Contour (Surface) Display

The Measured contour display is used to display the location of the measured surfaces and objects as well as the protective and warning fields. The
software uses the following colors to differentiate the surfaces and field boundaries:

Table 2. Contour colors

Contour Color
Minimum protective field Gray
Protective field Red
Warning field Green

Deactivated protective field  |Bright gray

Deactivated warning field Dark gray

Measured surfaces Yellow/red
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Mk AG4 CONFIG 1.1 - AG4 Zone Guard Application

File view Settings Configuration Protectivefwarning fields  System data  Security  Help

 Meowsdonowdwly | Dok | Pl dein | Spemdos |

2.378- |

2200 | —
2,000 —
1.600 1 o
1.600-— —1»

a

1.400-— ~

1.200-— -

1.000-— N

08e00-—

0E00-—

0.400-—

0.200-— —

L
|
:

0.000

-0.200
-0.300-, 1
2733 2800 2250 -2000 -1.750 1500 -1.250 1.000 -0.750 -0500 -0.250 0000 0.250 0500 0750 1.000 1.250 1.500 1.750 2.055

Units in meters

Field pairs active in the scanner. Cursor pozition in relation ta the lager scanner center paint: A

Selected field pairs: 1 | Pasition: %1217 m ¥1.517m | Angle|51.25° | Radius 1.945m || [

Data source: - File: | End position: | | Angle Fadius v
4G4 Connection | /4G4 Measurement moi|[PC > AG4 Canfiguration fWE T [Buthorized Customer [AC] |

Figure 3 Monitored Area Display (workspace)

NOTE: The dark blue circle visible in the detection shadow of the object in Figure 3 above, is a movable marker (cursor). This mouse-controlled cursor is
used when changing the boundaries of the protective and warning fields.

4.6  Navigation area

In the navigation area, both XY and polar coordinates of the cursor position are displayed. When using your computer mouse to locate a point in the
monitored area you can move your mouse pointer to a new point on the monitored area and click the left mouse button and see the new cursor position
coordinates. This feature is useful when creating protective and warning fields.

The arrow buttons are arranged in an Up, Down, Left, Right manner and allow the image to be moved within the display. Clicking on the middle button
optimally scales the frame and refreshes the display to include the entire monitored area.

4.7 Status Information area

In the on-screen Status line at the bottom of the screen, five fields are detailed as follows:
= Communication between PC and AG4
= AG4 status
= Operating mode of the software
= Active protective/warning field status
= Logged on user's authorization level

Banner AG4 Software Manual 144923 rev. A 02/2010 11
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Table 3. Status Information Area available data

Display

Status

AG4 - PC Communication

AG4 synchronous

PC synchronizes the connection between the PC and the AG4

AG4 connection

Data transfer between PC and AG4 is possible

AG4 Status

AG4 -> Measurement mode

Software receives measurement data from the AG4

AG4 -> Configuration

Software transfers configuration data to the AG4 (OSSDs are OFF)

AG4 -> Error

Error in the AG4 (OSSDs are OFF)

AG4soft Operating mode (identifies the active Worksheet)

PC -> Measured value display

Measured contour (monitored surfaces) display tools are active

PC -> AG4 configuration

Configuration tools are active

PC -> Protective/waming field
definition

Protective/warning field tools are active

PC -> AG4 system data

System data tools are active

Protective/warning field

PF, WF red Protective and Warning fields interrupted (OSSDs are OFF)
WF green Warning field interrupted
Empty Protective and Wamning fields clear

Logged-on authorization level

Operator (Op)

User is logged in with the Operator (Op) authorization level

Maintainer (Ma)

User is logged in with the Maintainer (Ma) authorization level

Authorized Customer (AC)

User is logged in with the Authorized Customer (AC) authorization level

Production (Pr)

User is logged in with the Production (Pr) authorization level

Development (De)

User is logged in with the Development (De) authorization level

12
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5 Configuring the Scanner (Setting Operational Parameters)

5.1 Configuration Requirements

Configuring the AG4 requires:

+ Connecting PC to AG4 (via RS232)

« Starting software and logging in as user

+ Creating or editing an AG4 configuration with the wizard
+ Creating protective field and/or warning field settings

+ Downloading the configuration to the AG4

+ Checking echo data (confirming the AG4 settings)

5.2  Installing software
NOTE: The AG4 is not required for installing the software on the PC.
Requirements:

+ If the PC and AG4 are already connected with one another, turn the AG4 power OFF.
+ Close all other Windows applications.

1. Insert the CD ROM.
The installation boots up automatically.

2. Open the Disk1 folder and double-click on the setup.exe file.
If the installation does not start automatically from the CD drive, open the folder \AG4soft\Disk1 and double-click the setup.exe file.
The installation wizard starts.

3. Click on [Next].
The installation wizard opens the software license agreement.

4. To agree with the software license contract, click Yes.

5. To agree with the recommended installation path, click Next.
or,

6.  To enter another path, Click on Browse.

7. Select another path and click on OK , then Next.

The wizard installs the software and creates a link on the desktop.

5.3 User Authorization

The following section describes the AG4soft program function access for each authorization level and the login process.

5.31 Authorization Level

The Authorization level login permits access to program functions on a need-to-use basis. In other words, the functions that are available depend on the
selected authorization level. Functions (buttons) that are not actionable in the software program appear as grayed-out versions of the original button.

No individual user names are required for the login, but an authorization level must be selected.

The functions for each authorization levels are listed below:

Banner AG4 Software Manual 144923 rev. A 02/2010 13
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Table 4. Authorization levels and available functions

Authorization level Functions

Operator (Op) + Adjust display

+ Display and analyze measured contour
+ Load configuration data from the AG4
+ Load status information from the AG4

+ Display diagnostics list

+ Create service file

+ Reset password

Maintainer (Ma) In addition to the Operator (Op) functions:

+ Load configuration data from file

+ Load configuration data from file and transfer to the AG4
+ Transfer configuration data from the PC to the AG4

+ Print configuration data

+ Print protective/waming field

Authorized Customer (AC) |In addition to the Maintainer (Ma) functions, full access to all user-relevant functions and parameters:
+ Save configuration data as a file

+ Change all configuration parameters

+ Reset AG4 to default values

+ Define and change protective/warning fields

+ Set reference contour in the protective field

+ Print and delete protective/warning fields

+ Load protective/warning field data from file

+ Save protective/waming field data

+ Transfer protective/wamning field data from the PC to the AG4
+ Calibrate the front screen

+ Change passwords

Production (Pr) Manufacturer-specific access

Development (De) Manufacturer-specific access

All authorization levels except Operator (Op) are protected with a password. Use the default password when you log in with the AG4 connected to the PC
for the first time, then change it immediately to a specific Scanner password. The following types of password are used:
+ Default password: Valid for the software and cannot be changed (BannerA or BannerM, depending on whether the user is an authorized
customer or a maintainer).
+ Specific password: Valid for a specific AG4 scanner. The software saves a user-defined specific Scanner password for each connected AG4,
which ensures that only authorized users can change the existing configuration.
The login situation determines which password must be entered in the software, as listed below.

Table 5. Login situations and password types

Login situation Password type

Using only the AG4soft program, without a connected AG4

Default d
Using the AG4soft program with a new AG4 (default settings) connected to the PC elault passwor

Using the AG4soft program with a user-configured AG4 connected to the PC

Specifi d
(that has had its default password changed to a specific password) pecilic passwor

14 144923 rev. A 02/2010 Banner AG4 Software Manual



Banner AG4soft Software Instruction Manual

5.3.2 Login

The AG4soft program can be used without an AG4 connected to the PC, but the functionality of the software is limited. The login procedure depends on
whether the PC is connected to an AG4. (In addition to the procedures listed below, you may also use the Programs > Banner Engineering > AG4soft
drop-down menus.)

Login procedure when the AG4 is not connected to the PC

Requirements:
+ AG4soft program is loaded on the PC
+ PC and AG4 are not connected

+ The R232 serial interface must be installed on the PC. If, for example, a laptop is used with a USB-t0-RS232 cable, the serial interface driver must
first be installed.

1. Click on the Microsoft Windows Start button in the tool bar. Click on the AG4soft icon Es&i&Elid on the desk top.
The software starts and a Banner AG4 start screen appears with an OK button.

2. Click on OK. The Change authorization level dialog box opens.
3. Select the Authorized Customer (AC) and enter the AG4soft default password: BannerA
4. Click on OK. An automatic wizard option appears and can be used to load an existing configuration file.

Login procedure when the AG4 is connected to the PC
You can use the software to transfer an existing configuration from one AG4 Scanner to another.

Requirements:

+ The AG4 is powered and connected to the PC.

o If you power the AG4 after the software start and have selected the Maintainer (Ma) or Authorized
Customer (AC) authorization level, you must then log in to the software with the default password.

1. Click on the AG4soft icon on the desktop. &l The software starts and a Banner AG4 start screen appears with an OK button.

2. Click OK.
= The AG4 automatically contacts the connected PC.
= The software automatically synchronizes the PC and the AG4.
= The software automatically transfers the configuration from the AG4 and checks the data.
= The Password and authorization level dialog box opens.

3. Select the Maintainer (Ma) or the Authorized Customer (AC) and enter the AG4soft default password.
When logging in for the first time (with a new AG4 connected to the PC), the default password for the required authorization level must be entered:

Maintainer (Ma). BannerM
Authorized Customer (AC). BannerA

5. Click on OK.

= After you've logged in with the Maintainer (Ma) or Authorized Customer (AC) authorization level for the first time, change the password in
order to provide better configuration security. This new password is the specific Scanner password. The default password will no longer permit
access for changing the configuration in this specific AG4 scanner.

= The AG4soft program checks for communication to the connected AG4.

Banner AG4 Software Manual 144923 rev. A 02/2010 15
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= The Scanner Status Information message appears. The status information includes administrative and safety parameter values. You can
compare the parameters with the required parameters of the current application with this information if necessary.

6. Click on EXIT. The wizard can be used to modify the existing configuration or you can load a configuration from a PC file. AG4soft authorized level
program functions can now be accessed.

A default configuration file is stored in examples in the AG4 program folder (see file path below). The file
) name is standard.rs and can be used as a template that can be changed for creating new configurations.

C:\Program Files\Banner Engineering\Banner AG\AG4soft\lexamples

5.4  Creating AG4 configurations

To create a new configuration or to change an existing configuration, an existing configuration must first be opened using the AG4soft program. A locally
saved configuration file or the configuration file from the AG4 Scanner can be accessed.

5.4.1 Load a configuration file from the AG4soft folder on the PC
A configuration can be loaded from the PC files. If an AG4 is not connected, the load process starts after the AG4soft login.
Requirement:

+ Logged in with the Maintainer (Ma) or Authorized Customer (AC) authorization level.

Select Safety Laser Scanner @

Safety Laser Scanner

1. Click the Configuration worksheet tab and click Hﬂ|

The Select Safety Laser Scanner screen opens (shown on right) and presents
a brief summary of the AG4 attributes.

Select the device that you want to configure.

This preselection sets device-dependent parameters and protective
field definitions!

2.Click on Exit.
Safety Laser Scanner features

The file selection menu opens. The examples file folder opens and the standard.rs e P e ok s e TR
file and others may appear. 4000 mim 0 ]

Supponed usage options

3. Select afile and click Open.

Danger zone guarding A
Leg detection -danger zone guarding
AGY -Automatic guided vehicles

The program loads the configuration file. A message declaring the file is now Passage conlrol -access guarding
Arm protection -point of operation guarding
loaded appears Hand protection -point of operation guarding
! Body pratection -danger zone guarding -
4. Click on OK. -

The configuration setting can now be modified.

54.2 Loading a configuration from the AG4
The configuration file from the AG4 Scanner can be loaded into the AG4soft program.
Requirements:

= AG4 is powered and connected to the PC.

= AG4softis not running

16 144923 rev. A 02/2010 Banner AG4 Software Manual



Banner AG4soft Software Instruction Manual

1. Click on the AG4soft desktop icon. EEkES
A message appears that declares the configuration data is being loaded from the scanner.
The login menu appears.

2. Login with Maintainer (Ma) or Authorized Customer (AC) using the default or specific password, whichever one applies.
A message reminding you to change the password may appear if the AG4 default password is still active.

3. Click on OK.
A message appears that declares that the program is ascertaining status information from the scanner.

4. Click on Exit.
Another message appears that asks if you want to edit the configuration with the wizard.
= Ifyou choose Yes the wizard steps you through the editing process.

= Ifyou choose Exit you can use the Worksheet functions to change the configuration settings. (see section XXX on page XX)

- If you start the AG4soft program before you connect to the scanner, the serial cable should be
connected to the PC (but not to the AG4). This cable connection allows the program to identify the correct
communications port.
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5.5  Change AG4 configuration parameters

Individual configuration parameters can be changed via the function specific Worksheet tools or by using the Configuration Wizard.

5.5.1 Change parameters with the Configuration Wizard

The parameters of the AG4 configuration can be changed using the wizard. To edit the configuration of an AG4, connect a AG4 to the PC, and turn on the
AG4 power, the configuration is loaded from the AG4 after the AG4soft login.

Requirements:
= Powered AG4 is connected to the PC

= Logged in to AG4soft as Authorized Customer (AC).
= The AG4 configuration will automatically load into the software program.

Note if the AG4soft does not connect with the scanner, check your PC comm. port settings to be sure
you are using the proper port. The AG4 connection status window should look like this:

EG4 Connection

The program will eventually display the Scanner status information window.

1. Click on Exit

The worksheet display will show the measured surfaces and the protective and warning fields.
2. Click on the Configuration worksheet tab and click on .
or, using the drop-down menu select:
3. Configuration > Wizard.
The Configuration Wizard presents a series of administrative and safety operational parameter choices.
4. Enter the values of the parameters that need to be changed in the respective fields.
5. Click Next to go the next page. Click Back to go the previous page.

6. Click on OK when all parameters have been entered. The configuration menu closes.

) . . pal. . .
7. To transfer the configuration to the AG4: Click on L=8l in the Configuration worksheet
= [fthe AG4 is connected to the PC, the configuration is transferred from the PC to the AG4.
=  Note that the new configuration is not saved to file on the PC yet.

= Clicking on either of the Measures contour or System data worksheet tabs will cause the memory message to appear to give you the
option, and remind you, to save a copy to file.

= More detail on the PC to AG4 configuration transfer and confirmation process is discussed in section 5.8.1
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5.5.2 Change individual parameters

The parameters of the AG4 configuration can be changed using the Configuration parameters menu below. Administrative and safety-relevant
parameters are combined in folders with the same name. Protective and warning fields that belong together are combined in the folders as Field pair 1 to
Field pair 7 respectively.

Configuration parameters.

= 2} Configuration parameters Parameters Curtent value Status

(0 Administrative parameters Application | Danger zone guarding

[=] Safetyrelevant patameters| (18] Response times

=0 F!eld Da!' 1 [‘_ﬂﬁlal segment measurement 0*0.36" R

+ D Ffdd Da!l 2 Stop segment measurement 528+0.36° R

: 8 :::: z:::j [18] Dust lsupplession Activated

&2 Field pait 5 @Pelmlled field pair switchovers

+ (] Field pair 6 Valid field pair selection with scanner start

+ (O Field pait 7 [16] 5K Data Version 0 R
[18]5K Data ID 40476 R
Date of last save 00:0001.01.1300 R

OK
Cancel
Print
Create text file

Configuration parametersiSafety-relevant parameters

1 Folder selection
2 Parameter selection
3 Change single value parameters in input area (inactive)

Figure 4 Configuration Parameters Main Menu

Parameters shown as R in the Status column are “read only” and cannot be changed.

-
1l

Requirements:

+ Logged in as Authorized Customer (AC).
+ Load a configuration in the software program.

1. Click the Configuration worksheet tab and Click on EI or, using the drop-down menu, select: Configuration > Change.
The Configuration parameters menu opens.

2. Click on the folder that contains the parameters that require modifying.
The program now displays the folder's parameters in the parameter selection field.

3. Double-click on the parameter that is to be changed.
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If a single value parameter has been selected, a sub-menu opens to the right of the status field. The current selection is shown and an entry field for
the new selection is provided.

Configura parameters

= & Conl parameters Current value Status
(20 Administrative parameters Application Danger zone guarding ( Dust suppression \
= Safelyrelevant parameters [16) Response times
=8 F!ald oY 1 [L@:]Slall segment measurement 0+0.36° R SR
: 8 E:::j g:: g 18] Stop segment measurement 528 0.36° R Activated
4 O Field pair 4 Dust suppression Activated N :
4 O Field pait 5 @Pem\itled field pair switchovers ew value
+ O Field pair 6 @Vaﬁd field pair selection with scanner start v
4 O Field pait 7 (18] SK Data Version 0 R
[18]5K Data ID 40476 R

(1] Date of last save 00:00 01.01,1300 R Accept

oK
Cancel
Print

\ Create text file /

Configuration parameters\Safety-relevant parameters

Figure 5 Configuration Parameters Menu

4. Select New Value for parameter as required then click Accept.
5. To print the configuration, in this menu click Print.

6. To save the configuration in the *.txt format click Create text file.

If a multi value parameter has been selected, a pop-up menu opens, showing the current values.

Configuration parameters

Safety-relevant parameters

Application Selection of the planned application and area of use
j of the Safety Laser Scanner

Danger zone guarding
. with definition of the requested resolution.
Resolution

This preselection defines further safety-relevant parameters and
specific protective field definitions!

Start behavior after switching on the Laser Scanner.
Caution:
J With 'Automatic start' selection a start waming
(optical/acoustic)
must be provided for or you must parameter the downstream safety
device with the 'Start interlock’ function!

Restart behavior
J Safety Laser Scanner start behavior
e 0 after release of the protective field PF during running operation.

—
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7. Select the appropriate fields as necessary and when complete, click OK.

8. When all required parameters have been changed confirm with OK in the configuration main menu.

The changed configuration can now be downloaded to the AG4 or saved in a file.

If the operating mode is changed before the changed configuration has been downloaded or saved, the Memory message appears:

The changed configuration data has not been saved yet.

[V Transfer data from PCto scanner.

[~ Save datafrom PCin afile.

oK Discard Cancel

™ Do not display message any more.

9. Ensure that the appropriate checkboxes are checked and confirm with OK.
The program executes the selected functions, or

10. Todiscard all changes to the configuration, click on the Discard button,
the program reverts to the previous configuration, or

11.  To edit the configuration, click on Cancel.

Banner AG4 Software Manual 144923 rev. A 02/2010

21



Banner AG4soft Software Instruction Manual

5.6  Save an AG4 configuration
To save the changed configuration, the configuration file can be downloaded to the AG4 or saved in a file on the PC.

(]

1l

_—

The configuration settings can be printed or saved as a text file in the *.txt format

5.6.1 Transfer configuration data from PC to AG4
In order that the changes to the configuration become active in the scanner, the changed configuration file must be transferred to the AG4.
Requirements:

= PC and AG4 are connected.

= Logged in with Maintainer (Ma) or Authorized Customer (AC) authorization level.
= Changed configuration file is loaded in the program.

I
1. Click on the Configuration worksheet tab and click on t_I .

or, using the drop down menu select:

2. Configuration > Transfer from PC to scanner.
The program checks the configuration file and downloads it to the AG4.

If only administrative parameters have been changed, the AG4 does not send any echo (confirmation) data. However, if safety-relevant
parameters have been changed, the AG4 sends echo data to the PC.

The Scanner echo data message appears:

Safety-relevant parameters
| Parameters | Value ‘
[18) Application Automatic guided vehicles (AGV) /Resolution: 70 mm
(18] Restart delay time after PF release 50 * 40 ms (2000 ms)
[18)PF response time 4 * 40 ms (160 ms)
WF respaonse time 5 * 40 ms (200 ms)
(18] Start segment measurement 0 (5049
(18] Stop segment measurement 528 (185047
(18] Start behavior Automatic start
(18] Dust suppression Activated

[18]Date of last save 15:3906.10.2008

[18]Permitted field pair switchovers FP 1
[18]Permitted field pair switchovers FP 2
[18]Permitted field pair switchovers FP 3
[18]Permitted field pair switchovers FP 4
[18)Permitted field pair switchovers FP§
(18] Permitted field pair switchovers FP 6
[18) Permitted field pair switchovers FP 7

Accept

Permitted with start - Switchover permitted to: 2. 3
Permitted with start - Switchover permitted to: 1, 3
Permitted with start - Switchover permitted to: 1, 2

Cancel

22

3. Check the echo data and confirm that it is correct then click Accept.
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The Scanner protective field echo data menu opens for each protective field (see image below).

™ Scanner, protective field echo data E
Description
Please check the protective field contour very precisely! SF1
2200~ I aximum values:
2.000- Front [rmm] 1100
Left [mm] 1201
1.800-
Right [rrirn] 1209
1.600-
Fratective field additional value Z5M to be
1,400 included
1.200- 66535 mm
Hote:
1.000-
Please see the technical
i i for further additi
0.800~ values required.
0.600-
0.400~ Date of last save:
16:17 20.04.2009
0.200-
0,000 Peimitted field pair switchovers:
Permitted with sart
0193 | i ] i | i ] i i ' i : i i ' | i '
2.200-2000 -1.760 -1.500 -1.250 -1.000 -0.750 0500 -0260 0000 0250 0500 0750 1.000 1.260 1.500 1.750 2000 2.200
Cancel

4. Check the protective field echo data for all protective fields.
5. Ifthe protective field echo data is correct, click Accept.
The next field echo data appears until all protective fields have been confirmed.
At the end of this process, the software checks the configuration file and transfers it to the AG4 again.

The Configuration data transfer from PC to Scanner message opens.
6. Click OK. The software saves the configuration file in the AG4 and now uses it as its active operating configuration.

5.6.2 Save configuration data as a file
The loaded configuration can be saved in a folder on the PC.

Requirements:

= Logged in with the Authorized Customer (AC) authorization level.
= The changed configuration file is loaded in the software.

i Select the Save configuration data as a file function if, for example, an AG4 is not connected
with the PC. A configuration saved on the PC can be transferred as a file later to the AG4.

_—

| Select a file to save. (3]
) . . ) . Saveir: [ enamples ~| ef -
1. Click on the Configuration worksheet tab and Click on or, using the Y ;Mp
drop-down menu select : File > Save configuration data as a file My Sandeds
The AG4 example file folder opens. H
esklop
2. Name the file and click on Save. The software saves the configuration file in
My Documents
the *.rs format. 8
-
My Computer
.
s e e | k| Save
Places - —
Saveashpe  |Configurstion fles [rs) | Cancel
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5.7  Create and edit protective/warning field configuration

To create a new protective/warning field configuration, load an existing protective/warning field configuration and change its field boundaries and save as
anew file.

An AG4 configuration must be loaded into the software so that changes can be made to
protective or warning fields. The data of an individual protective or warning field configuration

can be saved as its own file. When the AG4's configuration file is saved, the protective or
- warning field file is automatically included in the AG4's configuration file.
5.7.1 Load protective/warning field configuration

To create or edit a protective or warning field configuration, load an existing protective/warning field configuration into the AG4soft program.

Requirements:
= Logged in with the Authorized Customer (AC) authorization level.
= Aconfiguration file is loaded in the software.

1. Click on the Protective/warning fields definition worksheet tab and click ﬁ

or, using the drop down menu select:

2. File > Load protective/warning field from a file. ; opr—— 7
Look inc [ () examples ~| £ B
The AG4 examples folder opens. 3 2 sandard o
3. Select the file that you want and click Open. 'h’w’"“:.‘:

=

Desktop

The protective and warning fields appear in the o .
AG4soft worksheet display area. -
8
My Computer
«
_
Myprliaecl::rk File name: [ =l Open
Files of type: [ protective field fies (.5f] = Cancel

NOTE: Individual protective or warning field configurations can be loaded from a file. If an AG4 configuration is already loaded, all defined
protective/warning fields in it are automatically loaded.
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5.7.2 Edit protective and warning fields

Once the file is open in the AG4 soft program, the protective and warning fields boundaries and the reference surfaces can be changed.
Select protective or warning field
To edit a protective or warning field, a field to be displayed in the work space must be selected.

To select a field: _
1. Click on the Protective/warning fields definition worksheet tab and use the drop oot o - 0s
down field menu (see image on right), to select the protective of warning field that T

you want to change.

or, using the drop-down menu, select:

' Protectivefwarning fields selection

2. Protective/warning fields > Select protective/warning field
Protective/warning fields Protective field 1 v|

Use the Protective/warning field selection menu that appears (see image
right) , to select the protective of warning field that you want to change.

The software displays the protective (red) and warning field (green) boundaries as red and green respectively. The colors represent the field

boundaries of field pair 1. Although both fields of the 1°* field pair are shown in color in the work space below, only the protective field is “active”, that is,
only the protective field can be changed with the editing tools in the worksheet. Other field pair boundaries can be displayed and will appear in light gray if
the field pair is selected (see Selected field pairs window in the image below).

21k AGdsoft The active field that can be changed m
File Wiew Settings Configuration  Protectivejwarning fields  System data  Security  Help

QR Bl o SRS e <~ DSINIS] SIS el X 5

3.760-

3500
3.250

3.000
2.750

2.500

2,250
2.000

1.750 e
1.500

1.250 /
1.000 /
0.750
0.500 AN
0.250
0.000=

-0.250
-0.398-, I ! !
-3.760-3.600 -3.000 2500 -2.000 -1.500 -1.000 -0.600 0.000 0.500 1.000 1.500 2000 2500 3.000 3500 3.760

Urits in meters

/

.

)

{h

Figld pairs active in the scanner: Cursor position in relation o the laser scanner center point: A

Selected field pairs: 1.3 Fosition: #0893 m Y 3149m | Angle 7416° | Radius 3.273m - »

Diata source: Secanner End positian: = -0.900 m Y3171 m | Angle 7416 Radius 3. 296 m hd
|85G4 Synchron || ||F'E B3 Prnlective!waﬁhg.ﬁ&ld definition|| |Muthmized Customer [4C] ||

The Field pairs displayed

Figure 6. Protective and warning fields displayed
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The drop-down menu in the Protective/warning field worksheet tab below shows that Protective field 1 is active.
The selected pairs that are being displayed are field pair 1 (red & green) and field pair 3 (grey rectangles). See Select field pair window in the lower left corner of Figure 6.

Select field pair to be displayed
To set which field pairs are displayed in the work space, in the drop down menus area select: Fold poir display | |
1. Settings, then select

:-’_ Field pair 1
2. Displayed field pair selection and Bl ok
3. Check the pairs to be displayed (see image at right) [ Fieid peird
4. Click on OK.

oK | Cancel

The work space will show only those field pair selections in the work space

5.7.2 Defining protective and warning fields

Protective and warning field boundaries can be defined by entering numeric values or by using the graphic editing tools.

NOTE: The field boundary tools @ [Er can be accessed in the Protective/ warning fields worksheet or via the drop-down menu.

5.7.21 Numerical Changes
Requirements:

= Logged in with the Authorized Customer (AC) authorization level.
= The changed configuration file is loaded in the program.
= The protective or warning field is selected.

I=

1. Click on the Protective/warning fields definition worksheet tab and click on
or, using the drop down menu select:

2. Protective/warning fields > Define protective/warning field> Protective/warning field numerically.

The Define protective/warning field menu appears. front ecge (mm] [

3. Enter the values for the front, left and right edge in mm and click OK. Iett edge [mm] [

right eclge [mm]

oK | Cancel |

Your entered values have been incremented because of the angle resolution and consequently changed to the following values:

. . , %
A caution message for angle resolution will open and </

front edge [mm): 50

recommend a slight value adjustment. To accept the o ot
recommended VaerS, Should the displayed values be used?

4. Click Yes.

The window closes and the redefined field boundaries are displayed in the worksheet.
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5.7.2.2 Graphical Changes

A selected protective or warning field can be defined as an ellipse, a rectangle or a polygon.

When a graphic field change tool selected, the mouse pointer [% changes to a hand with pointed index finger and is used as a tool to define the field
boundary limits.

If the ellipse or rectangle field tool is selected, @ the field boundaries are created by pressing the left mouse button while moving the hand across
the work space. The cursor position corresponds with the outer-most point on the ellipse or the rectangle. The field changes dynamically as the pointer is
moved within the worksheet display.

Requirements:

= Logged in with the Authorized Customer (AC) authorization level.
= The configuration file is loaded in the software.
= The protective or warning field is selected.

5.1.3 Elliptic Field

1. Click on the Protective/warning fields worksheet tab and click on @I the elliptical field tool.
or, using the drop down menu select:
2. Protective/warning fields > Define > elliptical zone. The cursor changes to a hand with pointed index finger.
3. To designate the boundaries of the ellipse: Position the cursor near the area in the work space where you want to place the field.

4. Press and hold the left mouse button (a preview of the elliptical boundary appears) and move the cursor until the proper field size is established.

5. Release the button to set the field in the work space. A thin line displays as a preview of the elliptical zone, in addition to the existing zone.

b AG4soft

File Wiew Settings Configuration Protectivefwarning fields  System data  Security  Help

T eewstcoouwdwin | Coloaten | Prtectv/naring el dfro I swenaa |
aa@ ﬁﬂ ﬂ aaé Protective field 1 7 |®||l§| &|ﬁ|cﬂ|@| m I:l E @

1530~

1.400
1.300
1.200

1.100
1.000
£.900 - .
0,800
0,700 / \
0600 / ° \
0500 {/ \\
0.400

\

0.300 I
0.200

0100
0.000-——+
-0.100 —

-0.192-
B éEW -1.400 -1.200 -1.000 -0.800 -0.600 -0.400 -0.200 -0.000 0.200 0.400 0.600 0.800 1.000 1.200 1 4IDD 1 ‘5'48
Units in meters

k
|

Field pairs active in the scanner: Curzor position in relation to the laser scanner center point: ry
Selected fisld pairs 1 Position %0403 m | ¥ (0998 m | Angle | Radius || @
1. J

Data source: _ File End positior: & ‘ ¥ | Angle | Radius

|64 Synchion. || ||F'C -» Protective/warning field dehn\l\un“ HAthUnze\:I Customer [AC] ||

Figure 6. Elliptical Protective field 1 NOTE: During the field change operation, the X and Y values of the cursor position in the navigation area
define the maximum area boundary dimensions of the short and long axes of the ellipse.
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Correcting a field
= If you want to change the field shape repeat the process again.

= The old field boundary will be replaced with the new field boundary.

o If you accidentally click on the wrong tool button you can start over by pressing the Esc key on your PC.

1l

5.74 Rectangular field

|

= Click in the Protective/warning fields definition and Click
or, using the drop down menu select:
= Select Protective/warning fields > Define > rectangular zone. The cursor changes to a hand with pointed index finger.
To designate the boundaries of the rectangle:
1. Position the cursor near the area in the work space where you want to place the field.

2. Press and hold the left mouse button (a preview of the rectangular boundary appears) and move the cursor until the proper field size is
established.

3. Release the button to set the field in the work space.
The work space below shows a thin line preview of the rectangular field (no other field is shown).

File Wwiew Settings Configurstion Protectivefwarning fields  Swstem data  Security  Help

Protective/warning fields definition I_

[ Meosedeontouwdiply |
SURITY &6 To aRBlE Feeena el il B

1.530-

1.400
1.300

1.200

1100

1.000

0,300

0800

0,700

0.600
0.500

0.400

0.300

0.200

0100

il

0000+ e — e e e
IS L

0100

-0.192-
-1.%51 -1.400 -1.200 -1.000 -0.800 0600 -0.400 -0.200 -0.000 0.200 0.400 0.E00 0.800 1.000 1.200 1.4‘UU 1.5‘48
Lnits in meters

Field pairs active in the scanner: Cursor position in relation to the laser seanner center point: A

Selected field pairs i Pasilian: %0538 m | v[1.192m | Angle£335° | Radus1.334m || «l[@|p

Diata source: _ File: End position: * | Y | Angle | Fladius: H k4
[4G 4 Synchron. [ |PC -» Protective/warning field defirition|| [Buthorized Customer [AC] | [Define rectangular protectivewarming field

/4 start CoBEEmaAz e

Figure 7. Rectangular Protective field 1

NOTE: In the figure above, during the field change operation, the X and Y values of the cursor position in the navigation area define the maximum area
boundary dimensions of the short and long axes of the ellipse.
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Correcting a field
= If you want to change the field shape, repeat the process.

= The old field boundary will be replaced with the new field boundary.

5.7.5 Polygon Field

The order in which the corner points of the polygon are set depends on the workspace display:

= |fthe AG4 is displayed below in the workspace, set the boundary corner points from left to right.
= |fthe AG4 is displayed above in the workspace, set the boundary corner points from right to left.

1. Click on the Protective/warning fields definition worksheet tab and click M
or, using the drop down menu select:

2. Protective/warning fields > Define > polygonal zone.
The cursor changes to a hand with pointed index finger.

3. To define the first corner point of the polygon, position the cursor at that point on the work space and click the left mouse button

4. Left click the remaining points of the required polygon area.

The software shows a thin line as a preview of the polygon section.

1.530-

Please set the polygonal points from left ta right!

1.400

1.300

1.200

1.100

1.000

0,900
0.800

0.700

0600
0.500

0.400

0,300

0.200

0100

D00~ —— e e e T e
——] o

0100 ——

0192, . )
-1.551  -1.400 -1.200 -1.000 -0.600 -0.600 -0.400 -0.200 -0.000 0.200 0.400 0.600 0.800 1.000 1.200 1400 1.548

Uriits in meters

Field pairs active in the scanner: Cursor pasition in 1elation to the laser scanner center point:

Selected fisld pairs i Pasiion: R[080Tm|  Y1103m | Ange5400° | Radus[.363m || @M

Data sounce [sesren|  Fie End pasiion X078 | Y1.0%9m | Ange1500° | Radus[1.358m || W)

|4G4 Spnchran, [ |PC > Protective/waring field definition | |Authorized Customer [AC] | [Define polyganal pratective/waming field

74 start FnEEmaAazRen ™. (@, [2s. D= ALY s 18y, s

Figure 8. Polygon field shape. The figure above shows the first 3 sides of the polygon shaped protective field.

NOTE: In the figure above, during the field change operation, the X and Y values of the cursor End position display in the navigation area define the
corner boundary points of the polygon field.
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5. When the polygon shape is complete, Right-click to establish and display the polygon area (see complete polygon field below).

— g

NOTE: When you complete the polygon shape, the software connects the end points and accepts the field boundaries.
Correcting a field
= |f you want to change the field shape repeat the process with the new shape.

= The old field boundary will be replaced with the new field boundary.

Change protective and warning fields
A protective or warning field shape can be modified if needed.

Requirements:
= Logged in with the Authorized Customer (AC) authorization level.
= The configuration file is loaded in the program.
= The protective or warning field to be modified is selected.
Change a field shape
This function allows the user to modify or reshape the boundaries of a field by sections (see figure XX below).

The warning field shape below can be modified e.g. to create an unmonitored space for a passage way between the warning field (yellow line) and the
wall (green line). The program connects the two points with a straight line generates a new field boundary.

0

1.600 1,400 41,200 -1.000 -0.800 0800 0400 0200 -0.000 0200 0400 00D 0800 1.000 1200 1400 1600
Units in meters

Figure 9. Elliptic warning field that projects into a wall (green line) and material access route (not visible)
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Requirements:

+ Logged in as Authorized Customer (AC).
The configuration file is loaded in the software.
+ The warning field is selected.

= (Click the Protective/warning fields definition worksheet tab and click E

or, using the drop down menu select:

= Select Protective/warning fields > Change protective/warning field segment.

= The cursor changes to a hand with pointed index finger.
= The program displays the selected field boundary in bold.

1. Position the cursor at the 1% point on the work space.
(see work space right for example) Potre 1 Poire 2

2. Press and hold the left mouse button.

3. Release the button when the cursor is positioned properly
A guide line from the AG4 to this 1% point appears.
4. Position the cursor at the 2™ point on the work space.
5. Press and hold the left mouse button. el

1600 1400 1200 -1.000 0600 0800 0400 0200 000D 0200 Ddop nEop 0800 1000 1200 1400 1600
Units in metess

6. Release the button when the cursor is positioned properly | <

7. Right click to establish the new field shape.

Aline connects the points (see work space right for example)
and the new boundary is established.

600 -1.400 -1.200 1.000 0400 0600 0400 0200 0000 0.200 0400 0600 0do0 1000 1200 1400 160
Units in metets
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| e g | I I I o
N |\ I O O i
-
Set as many coordinate points as needed to shape the field. / —
(see work space right for example) / et
| 1 B
|
-1.400 -1.200 -1.000 -0800 -0.600 -0.400 -0.200 0.000 0200 0400 0600 0800 1.000 1.200 14‘00 1.600 1é001$
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5.7.6 Change all fields

Itis possible to change all of the AG4 protective fields or warning fields at the same time.

1. Click the Protective/warning fields definition worksheet tab and click ﬁ
or, using the drop down menu, select:

2. Protective/warning fields > Change protective/warning field segment with all fields.

A confirmation message appears (nght) Change all available protective fields

\__?/ Do you want to change the segments with all available protective figlds with this action?

] W

3. Click Yes to continue or No to reject.

4. Change the field shape as described in Change a field
shape, above.

NOTE: When the changes have been completed, all of the protective fields (as a group) and/or all of the warning
fields (as a group) will have had their boundaries changed in a similar manner though they will not necessarily
have the identical shape.

Changing all protective fields or all warning fields with the Change protective/warning field segment with all
= fields tool will produce identical field shapes or boundaries only if the field shapes are identical when you start
L the field change process.

5.1.7 Reduce field limits
The field limits of a protective or warning field can be reduced by establishing numerical values for the limits.

Requirements:

= Logged in with the Authorized Customer (AC) authorization level.
= The changed configuration file is loaded in the software.
= The protective or warning field is selected.

1. Click the Protective/warning fields definition worksheet tab and click. ﬂ

Reduce protectivefwarning field limits E|

or, using the drop down menu select:

2. Protective/warning fields > Reduce protective/warning field limit

|eft edge [mm] I |-2140
right edge [mm] ™ 12140

The Reduce protective/warning field limits menu appears (right).

3. Enter new values for the front, left or right edge in mm and click OK

[0]8 ‘ Cancel |

A message for angle resolution opens to recommend a value adjustment.

4. To accept the recommended values, click Yes.

The window closes and the redefined field boundaries are displayed in the worksheet.
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5.7.8 Blank out segments
Individual field segments can be blanked out or not monitored, by establishing two points on either a protective or a warning field boundary. The program
creates the unmonitored region between the points. The unmonitored region boundaries extend along a radial line to the AG4

1. Click the Protective/warning fields definition worksheet tab and click El

or, using the drop down menu select:

2. Protective/warning fields > Blank out

protective/warning field segment. I I VN — } } —
The pointed index finger cursor appears. N } }
3. Click on the 1 point on the field = "
/ N
(see work space right for example 7 \
/ \
/ \

Unis irn meters

L [T O O O
7 N\
4. Click on the 2" point on the work space y \
HHHHH HHHH AR AR === mnnn N USSR RN AR
L ——T I —
1.600 -1.400 1,200 -1.000 -0.800 -0.600 -0.400 -0.200 U.E;UU 0.200 0,400 0600 0800 1.000 1200 1.400 1.600

Units in meters

| 1 O O A O O
5. Right click i
//’
/ VL N\
\
The new field shape appears with the unmonitored section / V] \
clearly visible in the workspace. / \\ / \
\/
HHM.._:#__H_H_“"--JL .l...u,_._u___ HH

Units in meters
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5.8 Set the reference contour

A reference contour or surface in a protective field can be created by establishing two points on the field boundary. The software program establishes this
surface along the field boundary line between the two points. You cannot set a reference contour in a warning field. The reference can be a surface on a
machine or within an work area. The surface must be stationary with respect to the AG4 and must be within the protective field range for the application.

If the Passage control (3.5 meter range), Arm protection (2.25 meter range) or Hand protection (1.5 meter range) application is selected in the
configuration, the software automatically defines the entire protective field limit as reference contour. You can reset parts of the reference contour
retroactively.
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1 Reference contour
2 Transition area between protective field contour and reference contour
3 AG4

Figure 10.  Set reference contour

Requirements:
= AG4 powered and connected to the PC
= Logged in with the Authorized Customer (AC) authorization level.
= Aconfiguration file is loaded in the software.
= The protective or warning field is selected.
= Asegmentin a protective field is defined.
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When setting the reference surface, ensure smooth transitions between protective field with reference contour and
- protective field segments without reference contour. The reference contour must lie on the measured contour; the
11 protective field limit slightly before the measured contour.

1. Click the Protective/warning fields definition worksheet tab and Click ﬂ
or, using the drop down menu select:

2. Protective/warning fields > Define protective segment as reference contour

In the work space,

3. Click a point on the protective field boundary.

4. Click another point on the protective field boundary.

5. When the button is released, the reference is established.

The software shows a blue connection line from the starting point to the end
point of the reference contour.

—— T e e Y -

If it is necessary to create a reference contour that consists of several

sections, repeat the process until the contour corresponds with the desired s oem  odw 0o ofon ol odo  ofm  odm
. Urits in meters

display.

If it is necessary to delete a reference contour,

1. Click the Protective/warning fields definition worksheet tab and click g
or, using the drop down menu select:

2. Protective/warning fields > Reset reference contour definition for protective field
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5.9  Saving protective/warning fields

Protective and warning fields can be saved as follows:
+ When a AG4 configuration is saved, the software automatically saves all loaded protective and warning fields in the configuration file
+ The selected protective or warning field can be saved individually in a protective/warning field configuration file.
+ One or more of the displayed protective or warning fields can be downloaded together from the PC to the AG4 and saved there.

5.9.1 Save as afile
When protective or warning field changes have been made they can be saved on the PC for record keeping purposes or for later use..

If the AG4 is not connected with the PC, the changed protective/warning field configuration can be saved on the
PC as a file, then downloaded to the AG4 at another time. For complicated field boundaries or for fields that
supplement one another in switchover mode, a saved protective/warning field configuration can be transferred to
another field pair.

Requirements:
= Logged in with the Authorized Customer (AC) authorization level.
= The protective or warning field is loaded in the program and selected.

1. Click the Protective/warning fields definition worksheet tab and click ﬂ

or, using the drop down menu, select:

2. File > Save protective/warning field as a file. The AG4 examples folder opens.
3. Name the file and click Save.

The software saves the protective/warning field configuration file in the *.rs format.

5.9.2 Transfer protective and warning field configurations from the PC to the AG4

One or more of the scanner’s protective or warning fields configurations can be changed and transferred to the AG4 so that these new field configurations
can become active in the scanner.

Requirements:
=  The AG4 is powered and connected to the PC
= Logged in with the Authorized Customer (AC) authorization level
= The protective or warning fields from the Scanner are loaded in the [ @

software ¥ Protective field 1

= The field changes have been made v ‘Warning field 1
v Protactive field 2

1. Click the Protective/warning fields definition worksheet tab and click 1{_%'
or, using the drop down menu, select:
2. Protective/warning fields > Transfer changed protective/warning fields from

PC to scanner.

A message appears (example shown at right) that lists all the changed fields
that can be transferred to the Scanner. Deselect (uncheck) the box for any

field that you do not want to transfer to the Scanner, and Cancel

3. Click on Transfer.
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The program sends to new field parameters to the AG4. A copy of the echo data for each change field is defined in the program for review. If field
data are correct,
4. Click on Accept.

The program establishes and activates the new fields in Scanner and the Transfer protective/warning data from PC to Scanner message
opens.

5. To confirm the message, click on OK.

The software saves and activates the changed protective and warning field files in the AG4.
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6 Documentation, Passwords, Maintenance

6.1

Configuration Documents

The following AG4 status and configuration information can be printed:

P

6.1.1

Status information

AG4 configuration
Protective/warning field configuration
Diagram

If a printer is not connected the information can be saved as a file in the *.txt format.

Print status information

The AG4's status information can be printed or saved as a text file and includes:

Administrative parameters, e.g., name, serial number

Safety-relevant parameters, e.g., protective field additional distance values, startup process
Permitted field pair switchovers

Date a zone was last saved

Output resolution

Requirements:

The program is connected with the AG4
The status information from the AG4 is loaded

i3
Click the System data worksheet tab and click ﬁ

1.
or, using the drop down menu, select:
2. System data > Transfer status information from Scanner to PC
The Scanner status information dialog appears.
3. Click Print to select a printer.
4. Click on Create text file to create a text file.
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6.1.2 Print AG4 configuration
The AG4's configuration can be printed or saved as a text file.

The printout and the text file includes the following information:

= Printdate

= User

= Data source

= Administrative parameters

= Safety-relevant parameters

= Name of all field pairs and date they were saved

Requirements:

= The program is connected with the AG4
=  You have loaded the status information from the AG4
Printing

1. Click the Configuration worksheet tab Click on %

or, using the drop down menu, select:

2. Configuration > Print.

6.1.3 Create text file
1. Click the Configuration worksheet tab and click J

or, using the drop down menu, select:
2. Configuration > Change
The Configuration parameters dialog box opens.

3. Click on Create text file.

6.1.4 Print protective/warning field configuration

A protective/warning field configuration can be printed and include

= Name and description of the zone
= Date the zone was last saved

= Permitted field pair switchovers
= Minimum object width

= Printdate

= User

= Data source

= Serial number

= AG4 name

= Graphic display of the zone

= Maximum values

=  Blanked out segments
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Requirements:

= The software is connected with the AG4
= A AG4 configuration is loaded in the software

1. Click the Protective/warning fields definition worksheet tab and click J
or, using the drop down menu, select:
2. Select Protective/warning fields > Print

The Print protective/warning fields dialog opens.

The protective/warning field and optimized display can be selected.

3. Click on Print.

6.1.5 Print work space diagrams
Work space diagrams (measured surfaces, protective and warning fields) may be saved as bitmap files in the *.bmp format and then printed.
Requirements:

= The program is connected to the AG4
= A AG4 configuration is loaded in the software

1. Select View > Save diagram as a file.

2. Locate file in AG4 software program (C:\Program Files\Banner Engineering\Banner AG\AG4soft\examples) and open the appropriate bitmap
program to view or print.
Banner AG4 Software Manual 144923 rev. A 02/2010
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6.2 Calibrate front screen

A

CAUTION . .. FAULTY CALIBRATION CAUSED BY DIRTY OR SCRATCHED FRONT SCREEN

= Only calibrate front screens that are clean and free of scratches, cracks, abrasions or other marks that could impair
pulsed light signal transmission.

= Clean the front screen with the Cleaning Set (AG4-CLN1 or AG4-CLN2)

If the AG4's front screen has been replaced for any reason, the AG4 must be re-calibrated. If not, the correct safety functioning of the AG4 can no longer
be guaranteed.
Requirements:

= The AG4's front screen is replaced

=  The AG4 is connected with the PC

= The ambient temperature is between 20 and 25°C

=  Logged in with the Authorized Customer (AC) authorization level

1. Click the System data worksheet tab and click J@I pibratlng e, (i2nt serssn, x|
Calculated reference values of the front screen measured distances
or, using the drop down menu, select: lepi Jiepz [iEDs [iED4 DS [iEDe
Max. value Channel 1
Limit value
. Min. value
2. Select System data > Calibrate the front screen. Mex value Channel 2
Limitvalue
Min. value

The Calibrate the front screen dialog opens:

The front screen may only be calibrated after a

3. Enter the password FS8LED and click Calibration. CBlciialed Veluxz of s rSierce Hintaroes front screen change!
The software starts the calibration process and S— T T R e T e
shows the calculated values of the front screen L
measured distances and the reference distances in Mo vokoe Chom2 Calibrasion password
the dialog. T [

4. Click Exit to close the dialog.

The AG4 is now re-calibrated with the new front screen.
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6.3  Change password
The password with which users of the Maintainer (Ma) or Authorized Customer (AC) authorization levels log in on the AG4 can be changed.
Examples:

+ With the first login of the AG4, users of the authorization levels Maintainer (Ma) or Authorized Customer (AC) use the Default password. The
Default password must be changed to a Specific password.
+ A user of the Maintainer (Ma) authorization level has forgotten the password or entered it wrong several times

' A password must be at least six and a maximum of eight characters long. Combinations of
letters and numbers may be used as well as both lower and uppercases.

Requirements:

+ Logged in with the Authorized Customer (AC) authorization level
+ The software is connected with the AG4

1. Select Security > Change password.

The Change password dialog opens. In the Password selection list;

2. Select the authorization level for which you want to change the default password.

3. Enter the new password in the New password
4. Enter the password again in the Repeat password field

5. Click OK. The software transfers the new password to the AG4 where it is then saved.

6.4  Reset password

If a user at the Authorized Customer (AC) authorization level has forgotten their specific password or entered it incorrectly several times, they cannot log in
on the AG4. The Change password function is therefore not accessible.

Instead, the specific password must be reset. The Reset password function is available for users of the Operator (Op) authorization level and requires a
password to access. During a telephone call with the Applications department a one-time password can be created, which the manufacturer confirms and
the customer subsequently uses in order to create a new specific password

To reset your specific password, compile the information listed below and contact Banner Engineering. Provide the following information:

= Your company address

= Your company contact person’s name

= Atelephone number where they can be reached

= The AG4 serial number (below the bar code on the label on the side of the AG4)
How to Contact Banner Engineering
To contact the Safety Application Engineering, call Banner's North American headquarters at:

763-544-3164

1-888-373-6767 (toll free)

Banner Engineering Corp., 9714 Tenth Ave. North, Minneapolis, MN 55441.
Or you can also send the information via email to: sensors@bannerengineering.com

Or you could contact your local Banner sales partner and provide them with the information above.

Either way, one of the Safety Applications Engineers will contact you and take you through the following steps.
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6.5  Create a one-time password

Requirements:

= Logged in with the Operator (Op) authorization level.
= The program is connected with the AG4.

1. Select Security > Reset password.
The Set new password with one-time password dialog opens.

2. Onthe Create one-time password tab select Create.
The software loads the one-time password from the AG4 and shows it in red.
When the Banner Engineering Safety applications engineer has the one-time password, they will create a new password.
3. Select the Set new password tab,
4. Enter the one-time password in the Confirmed password field,
5. Enter the new password in the New password field,
6. Repeat the entry in the Repeat password field,

7. Click OK

The program communicates with the connected AG4 and saves the new password for the Authorized Customer (AC) authorization level in the AG4.

The new password is effective after a restart of the software.
6.6  Create diagnostics list and service file

6.6.1 Create diagnostics list

The AG4 will generate a diagnostic list that can be used to identify operation problems and remedies (refer to the AG4 Product Manual for information on
diagnostics and remedial steps).

The diagnostics list contains the following information:

= AG4 serial number

= Firmware version

= Date the diagnostics list was created

= List of the last eight incidents that occurred with place, number and parameters
Requirement:

= The PCis connected to a powered AG4 with the AG4soft program running

1. Click the System data worksheet tab and Click £&2
or, using the drop down menu, select:

2. System data > Display the Scanner diagnostics list
The Diagnostics list dialog box opens.

3. Click Re-load to update the diagnostics list.

4. Click Print to print the diagnostics list.

5. Click Save to save the diagnostics list in the *.txt format.
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6.6.2 Create service file

A service file contains the configuration, diagnostics and system data of a connected AG4 and can be created in the *.sd¢ format.

This file can be sent to sensors@bannerengineering.com in cases where diagnose information is needed to solve an application or operation problem.

Requirement:

= The PC is connected to a powered AG4 with the AG4soft program running

1. Click the System data worksheet tab and click @
or, using the drop down menu, select:

2. System data > Create service file
A dialog box for saving the service file opens.
3. Name the file and click Save.
The program saves the service file in the *.sf format.

4. Send an e-mail with the service file attached to sensors@bannerengineering.com with the following information:

= Company address

=  Company contact person’s name

=  Contact person’s telephone number

= AG4 serial number below the bar code on the label that's on the side of the AG4)
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An overviews of the AG4soft program menu items, icon functions and tools can be found in this chapter.

7.1 Menu

The Menu chapter gives an overview of all menus and menu items.

Please note that the available menu items depend on both the selected authorization level and the selected

-

L operating mode. If, for example, the AG4 is to be configured, first an Authorized Customer (AC) level log in is

— needed and secondly, the AG4soft program must be in Configuration mode.

7141 File

Table 6. Menu items in the File menu

Menu item

Function

Load protective/warning field from a file

Opens a single protective or waming field configuration file

Save protective/waming field as a file

Saves a selected protective or warning field configuration as a file.

Load configuration data from file

Opens an AG4 configuration file.

Save configuration data as a file

Saves the loaded AG4 configuration as a file.

Exit configuration program

Exits the software.

71.2 View

Table 7. Menu items in the View menu

Menu item Function

Zoom Reduces the work space and the displayed diagram in steps.

Unzoom Enlarges the work space and the displayed diagram in steps.

Show all Enlarges the work space and the displayed diagram to full size of 70 x 70 meters.

Save diagram as a file

Saves the displayed diagram as a bitmap file in the *.bmp format.
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713 Settings

Table 8. Menu items in the Settings menu

Menu item

Submenu

Function

Operating mode

Measured contour display

Changes to the Measured contour display operating mode.

Configuration

Changes to the Configuration operating mode.

Protective/warning fields definition

Changes to the Protective/warning fields definition operating
mode.

Changes to the System data operating mode.

PC configuration

System data

Opens a dialog box in which you select the serial interface and the
Interface

transfer rate.

Opens a dialog box in which you select the language of the interface
Languages

texts.

Change diagram color

Changes the color of the work space from black to white to optimize it
for printouts.

Rotate contour display by 180°

Rotates the contour display in the work space to adjust the display to
the AG4's mounting situation.

190° protective/warning fields

Extends the display of the protective/warning fields for the definition
by 10°. This setting does not change the measured value recording.

Opens a dialog box in which you select the field pairs that are to be

Field pair di
ield pair display displayed on the work space.
Opens a message that displays all communication processes
L performed since the software was last started.
Activities list

With the MotionMonitoring function, the activities list shows the
individual actions and provides the status of the speed monitoring.
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714 Configuration

Table 9. Menu items in the Configuration menu
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Menu item Function
Wizard Opens the configuration wizard with which you change the configuration parameters.
Change Opens a dialog in which you change individual parameters.

Set default values in the scanner

Sets the AG4's configuration back to the default status.

Printing

Prints the configuration file.

Load from file and transfer to scanner

Opens an existing configuration file and transfers the data to the AG4.

Get from scanner

Loads the configuration file from the AG4 into the software.

Transfer from PC to scanner

Transfers the configuration file to the AG4.

715 Protective fields /warning fields

Table 10. Menu items in the Protective/warning fields menu

Menu item Submenu

Function

Protective/warning field selection

Opens a dialog box in which you select the displayed protective/warning
field.

Changed protective/warning fields

Opens a dialog box in which all protective/waming fields that were changed
since the last save are marked.

. Opens a dialog box in which you define the edges of a selected
Numerical field entry . .
protective/warning field.
- Enables an elliptical protective/warning field to be defined on the work
Elliptical zone
space.
Define
Enables a rectangular protective/warning field to be defined on the work
Rectangular zone
space.
Enables a polygonal protective/waming field to be defined on the work
Polygon zone
space.
Ch tective/waming field
Change segan:Z‘: tpro ecliveiwaming fie Enables a segment to be changed in the selected protective/waming field.
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Change protective/waming field
segment for all field

Enables a segment of all protective or all waming field boundaries to be
changed at the same time.

Reduce zone limits

Opens a dialog box in which you reduce the zone limits of the selected
protective/warning field.

Enables a segment to be blanked out in the selected protective/warning field

Blank out segments
contour.
Set Enables a reference contour to be defined in the selected protective field
contour.
Reference contour
Reset Enables a reference contour to be highlighted in the selected protective field

contour.

Delete

Deletes the selected protective or warning field.

Printing

Prints the graphic display and some parameters of the selected
protective/warning field.

Transfer from PC to scanner

Transfers one or more selected protective/warning field configurations to the
AG4.

71.6 System data

Table 11. Menu items in the System data menu

Menu item Function
Load status information from the AG4 Transfers the status information from the AG4 to the software.
Display the scanner's diagnostics list Loads an incident list from the AG4 and opens the list in a dialog box.
Create service file Opens a dialog box to save the service file in the *.sdc format.
Calibrate the front screen Opens a dialog in which you calibrate a new front screen.
Resets the safety-related switching outputs on the AG4 (Reset), required, for example,
Reset scanner .
after cleaning.
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717 Security

Table 12. Menu items in the Security menu
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Menu item

Function

Change authorization level

Opens a dialog box in which you can log in with another authorization level.

Change password

Opens a dialog box in which you enter a new password for the selected authorization
level for the login on the AG4.

Reset password

Opens a dialog box in which you enter a new password for the Authorized Customer
(AC) authorization level for the login on the AG4.
Need to contact Banner for access to this function.

71.8 Help

Table 13. Menu items in the Help menu

Menu item Function
AG4 Product Manual Opens the AG4's Product manual as a PDF file.
AG4soft Manual Opens the AG4soft configuration and diagnostics software manual as a PDF.

AG4 Applications information

AG4 System Checkout summary

Opens copy of the AG4 reference material

Opens copy of the AG4 Checkout procedures

7.2 Interface Button Functions

The AG4soft interface has worksheet toolbars to display buttons for various functions summarized in the tables below.

7.21 Common Worksheet Buttons

Table 14. List of buttons and associated functions

Icon Button/Function

Comment

i)

Zoom

Reduces the work space and the displayed diagram in steps.

@ Unzoom

Enlarges the work space and the displayed diagram in steps.

Q@ |showal

Enlarges the work space and the displayed diagram to full size of 70 x 70 meters.

@ Change authorization level

Opens the Change authorization level dialog box. You can log in with another
authorization level.

E Exit configuration program

Exits the software.
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7.22 Measured contour display buttons

Table 15. Measured contour display buttons

Icon Button/Function

Comment

ﬂ Displayed field pairs selection

Permits field pair boundaries to appear in the workspace

7.2.3 Configuration buttons

Table 16. Configuration buttons

Icon Button/Function

Comment

Load configuration data from file

Accesses the AG4 folder for configuration file review or changes

@ B

Save configuration data as a file

Save a configuration file in the folder

(]

Print configuration data

Prints data

i3

Load configuration data from a file and transfer to scanner

Opens configuration file and sends it to the AG4

P-E’ Retrieves configuration data from scanner
. Sends a configuration to the AG4 for use as the active operational
LF.;. Transfer configuration data from PC to scanner 'gurat ‘ Ve operal

settings

B

Change configuration data with the wizard

Step by step process for beginners

=

Change configuration data

Accesses a table of parameters that summarizes a configuration.
Some parameters can be changed with the use of this function.

£

Set default configuration values in the scanner

A read only file used as a template to start a new configuration.

Banner AG4 Software Manual 144923 rev. A 02/2010

51



723

Protective/warning fields definition buttons
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The following buttons are used for specific functions in the Protective/warning fields definition worksheet.

Table 17. Protective/warning fields definition buttons

Icon

Button

Function

=

Displayed field pairs selection

=

Load protective/warning field from a file

=]

Save protective/waming field as a file

&l

Print protective/waming field

No image

Select protective/warning field

A drop down field selection window in the Protective/warning field
worksheet. Used to enable the field that in the workspace for editing purposes.

5!

Enter protective/warning field numerically

For setting field boundary limits numerically.

]

Define elliptical protective/waming field

For setting an elliptical field boundary shape.

[}

Define rectangular protective/warning field

For setting a rectangular field boundary shape.

Define polygonal protective/waming field

For setting a polygon field boundary shape.

=z | &

Change protective/wamning segment

For editing an existing field boundary.

Change protective/warning segment with
all fields

For editing all existing field boundaries at the same time.

Reduce protective/warning field limits

For reducing an existing field boundary.

= |2 | Z

Blank out protective/warning field segment

For creating an unmonitored zone within an existing field boundary.

=

Define protective field segment as
reference contour

For creating a reference segment within a field boundary. Used when the
application requires a monitored reference surface for greater safety integrity.

=

Reset reference contour definition for
protective field segment

For resetting the reference surface limits

X

Delete protective/warning field

For eliminating the reference surface limits

[53]

Transfer changed protective/waming fields
from PC to scanner

For transferring only the protective/waming field information to the AG4.

52
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724 System data buttons
The following buttons are used for specific functions in the Protective/warning fields definition worksheet.

Table 18. System data buttons

Icon Button Function

|:£

Transfer status information from Scanner to PC |For reviewing the operations settings of the AG4

Display the scanner's diagnostics list Displays information needed for trouble shooting and remedial actions

B

Create service file

i

Calibrate the front screen Used after cleaning or replacing the screen (window)
M Reset scanner Returns the AG4 to its factory configuration settings
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The list of standards below is included as a convenience for users of this Banner product. Inclusion of the standards befow does not imply
that the product complies specifically with any standard, other than those specified in the Specifications section of this manual.

SOURCES

OSHA Documents
Superintendent of Documents
Government Printing Office
P.O. Box 371954

Pittsburgh, PA 15250-7954

Tel: (202) 512-1800
hitp:/fwww.osha.gov

ANSI Accredited Standards

American National Standards Institute (ANSI)
11 West 42nd Sireet

New York, NY 10036

Tel: (212) 642-4900

hitp:/fwww.ansi.org

B11 Documents

Safety Director

The Association for Manufacturing
Technology (AMT)

7901 Westpark Drive

McLean, VA 22102

Tel: (703) 893-2900
hitp:/fwww.mfgtech.org

RIA Documents

Robotics Industries Association (RIA)
900 Victors Way, P.O. Box 3724

Ann Arbor, Ml 48106

Tel: (734) 994-6088
hitp:/fwww.robotics.org

NFPA Documents

National Fire Protection Association
1 Batterymarch Park

P.O. Box 9101

Quincy, MA 02269-9101

Tel: (800) 344-3555
hitp:/fwww.nfpa.org

Alternate sources for these, plus IS0,
IEC, EN, DIN, and BS Standards:

Global Engineering Documents
15 Invemess Way East
Englewood, CO 80112-5704

Tel: (800) 854-7179
hitp:/fwww.global.ihs.com

National Standards Systems Network
(NSSN)

25 West 43rd Street

New York, NY 10036

Tel: (212) 642-4980
hitp:/fwww.nssn.com

Document Center, Inc.

111 Industrial Road, Suile 9
Belmont, CA 94002

Tel: (650) 591-7600
http:/fwww.document-center.com

U.S. Application Standards

ANSI B11.1 Mechanical Power Presses
ANSI B11.2 Hydraulic Power Presses
ANSI B11.3 Power Press Brakes

ANSI B11.4 Shears

ANSI B11.5 Iron Workers

ANSI B11.6 Lathes

ANSI B11.7 Cold Headers and Ccld Formers
ANSI B11.8 Drilling, Miling, and Boring
ANSI B11.9 Grinding Machines

ANSI B11.10 Metal Sawing Machines
ANSI B11.11 Gear Cutting Machines

ANSI B11.12 Roll Forming and Rell Bending
Machines

ANSI B11.13 Single- and Multiple-Spindle
Autcmatic Bar and Chucking Machines

ANSI B11.14 Cail Sliting Machines

ANSI B11.15 Pipe, Tube, and Shape
Bending Machines

ANSI B11.16 Metal Powder Compacting
Presses

ANSI B11.17 Horizontal Extrusion Presses

ANSI B11.18 Machinery and Machine
Systems for the Processing of Coiled Sirip,
Sheet, and Plate

ANSI B11.19 Performance Criteria for
Safeguarding

ANSI B11.20 Manufacturing Systems
ANSI B11.21 Machine Tocls Using Lasers

ANSI B11.22 Numerically Centrolled Turning
Machines

ANSI B11.23 Machining Centers
ANSI B11.24 Transfer Machines
ANSI B11.TR3 Risk Assessment

ANSI/RIA R15.06 Safety Requirements for
Industrial Robets and Robot Systems

NFPA 79 Electrical Siandard for Industrial
Machinery

OSHA Regulations

OSHA Documents listed are part of: Code

of Federal Regulations Title 29, Parts 1900
to 1910

OSHA 29 CFR 1910.212 General Require-
ments for (Guarding of} All Machines

OSHA 29 CFR 1910.147 The Control of
Hazardous Energy (lockcuttagout)

OSHA 29 CFR 1910.217 (Guarding of)
Mechanical Power Presses

International/European Standards

ISC 12100-1 & -2 (EN 29241 & -2) Safety
of Machinery — Basic Concepls, General
Principles for Design

ISO 13857 Safety Distances . . . Upper and
Lower Limbs

ISO 13850 (EN 418) Emergency Stop
Devices, Functional Aspects — Principles for
Design

ISO 13851 (EN 574) Two-Hand Centrol
Devices — Functional Aspects — Principles for
Design

ISO 62061 Functicnal Safety of Safety-
Related Electrical, Electronic and
Prcgrammatle Control Systems

ISO 13849-1 (EN 954-1) Safety-Related
Parts of Control Systems

ISO 13855 (EN 999) The Pcsitioning of
Prctective Equipment in Respect to Approach
Speeds of Parts of the Human Body

I1SO 14121 (EN 1050) Principles of Risk
Assessment

ISO 14119 (EN 1088) Interlecking Devices
Associated with Guards — Principles for
Design and Selection

IEC 60204-1 Electrical Equipment of
Machines Part 1: General Requirements

IEC 61496 Electrc-sensitive Protection
Equipment

IEC 60529 Degrees of Protection Provided by
Enclosures

IEC 60947-1 Low Voltage Switchgear
— General Rules

IEC 60947-5-1 Low Voltage Switchgear
— Electromechanical Control Circuit Devices

IEC 60947-5-5 Low Voltage Switchgear
— Electrical Emergency Stop Device with
Mechanical Laiching Function



For more information:
Contact your local Banner
representative
or
Banner Corporate Offices
around the world.

Asia — China
Banner Engineering China
Shanghai Rep Office
Rm. G/H/I, 28th Flr.
Cross Region Plaza
No. 899, Lingling Road
Shanghai 200030 CHINA
Tel: 86-21-54894500
Fax: 86-21-54894511
www.bannerengineering.com.cn

sensors@bannerengineering.com.cn

BANNER .

more sensors, more solutions

Corporate Headquarters

Banner Engineering Corp.
9714 Tenth Ave. North

Mpls., MN 55441

Tel: 763-544-3164
www.bannerengineering.com
sensors@bannerengineering.com

Asia — Japan
Banner Engineering Japan
Cent-Urban Building 305
3-23-15 Nishi-Nakajima
Yodogawa-Ku, Osaka 532-0011
JAPAN
Tel: 81-6-6309-0411
Fax: 81-6-6309-0416
www.bannerengineering.co.jp
mail@bannerengineering.co.jp

Europe

Banner Engineering Europe
Park Lane

Culliganlaan 2F

Diegem B-1831 BELGIUM
Tel: 32-2 456 07 80

Fax: 32-2 456 07 89
www.bannereurope.com
mail@bannereurope.com

Asia
Banner Engineering Asia —
Taiwan
Neihu Technology Park
5F-1, No. 51, Lane 35, Jihu Rd.
Taipei 114 TAIWAN
Tel: 886-2-8751-9966
Fax: 886-2-8751-2966
www.bannerengineering.com.tw
info@bannerengineering.com.tw

Latin America

Contact Banner Engineering Corp.
(US) or e-mail

Mexico:
mexico@bannerengineering.com
Brazil:
brasil@bannerengineering.com

India

Banner Engineering India
Pune Head Quarters

Office No. 1001

Sai Capital, Opp. ICC
Senapati Bapat Road

Pune 411016 INDIA

Tel: 91-20-66405624

Fax: 91-20-66405623
www.bannerengineering.co.in
india@bannerengineering.com

WARRANTY: Banner Engineering Corp. warrants its products to be free from defects for one year. Banner Engineering Corp. will repair or replace,
free of charge, any product of its manufacture found to be defective at the time it is returned to the factory during the warranty period. This warranty
does not cover damage or liability for the improper application of Banner products. This warranty is in lieu of any other warranty either expressed or

implied.




